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MassArt Moodle Online Course Sites  

     Moodle: Modular Object Oriented Dynamic Learning Environment  

 

Using Moodle for Course Activities and Materials 

Moodle course sites can be used to support both web-enhanced classroom courses and fully 

online courses. The content of a Moodle course site is accessible to the enrolled students, the 

instructor, and the MassArt Moodle support staff. 

  

Support for many resources and activities are available in Moodle but a course may need only a 

few of the simplest tools to be successful. What uses of web support for your course activities 

and content will most effectively enrich your students’ creative growth and learning? How do 

you want your students to interact about the course content online with you and with each 

other? What information, files, links, and media should every student have access to? Would it 

be helpful to have your students use a course site to submit their work and do peer review? 

 

Using Moodle to give students access to teachers’ classroom presentations has been very 

helpful, especially in courses that involve many PowerPoint slide presentations. If PPT files are 

saved as PDFs and posted in Moodle, students can view them on the course page after class. 

 

Using Moodle Advanced Forums to support guided discussions about course content outside 

the classroom has been very effective. Instructors post questions after class on issues related to 

the class session, and students respond with their thoughts and interact with each other during 

the week. This is one of the best uses of a course site since it enhances pedagogically effective 

student engagement in the course content outside of class. Providing guidance to prepare for 

classroom discussions has extended and enriched the classroom discussions in some courses. 

 

The use of Moodle Forums for peer review of essay drafts has also been very effective. The 

instructor posts guidance on critical reading and the students work in groups, reviewing each 

other's work and sharing their reviews in Moodle Forums prior to writing a final draft. Students 

say that reading each other's work and seeing each other's critiques of each other's work helps 

them to be more thoughtful and self-critical when they write their own final drafts. 

 

Logging Into the MassArt Moodle Web Site 

 

The web link to our MassArt Moodle course site homepage is: 

     moodle.massart.edu 

When you reach the MassArt Moodle home page, there is small type at the top right corner of 

the window with "(Log in)". 

http://moodle.massart.edu/
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To log in, enter your MassArt email username (without @massart.edu) and MassArt password 

and then click the [Log in] button. If you do not know your password yet, or have difficulty with 

an expired password, call the help desk. 

     Tech Central Help Desk Phone: (617) 879-7888 

     Tech Central Help Desk Email: helpdesk@massart.edu 

After you have logged in, your Moodle Dashboard appears with the links to your course sites. 

Click your course name link to open your course site. 

  

To log out, click your name at the upper right to access your personal menu and select "Log 

out". There is also an automatic logout when you have not interacted with the site for 2 hours. 

  

For assistance planning, creating and using your Moodle course sites: 

     Hubert Hohn <hhohn@massart.edu>,  (Use the email - Not in-Tower #724,   (617) 879-7289) 

  

Student Access 

The default state of a new course site is inaccessible to your students while you are creating it. 

The course names will be dark gray if student access is not turned on. When your course site is 

ready for student access, click "Edit settings" in the menu accessed in the dark blue gearwheel 

icon at the upper right on the course page. Turn on student access by changing Course visibility 

[Hide] to Course visibility [Show] on the settings page. Then scroll down and click (Save 

changes) at the base of the "Edit course settings" page. 

  

Inform Your Students About Accessing and Using Your Moodle Course Site 

Your students will also log into your MassArt Moodle course site using their MassArt email 

username and password. Remind your students to 

 • Access the Moodle web site:  moodle.massart.edu 

 • Log in at the upper right with their MassArt email username and password 

 • Access the course name links on their Moodle Dashboard. 

  

It is very helpful to briefly demonstrate access to your Moodle course site in your first class 

session, and to remind your students of your Moodle activities and content on a weekly basis. 

This is especially important in freshman courses since the first-year students have no experience 

using Moodle as part of their interaction and learning. 

  

Building Your Course Site  

  

Course Site Structure (Blue gearwheel menu / Edit settings - scroll down to Course format) 

mailto:helpdesk@massart.edu
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Moodle course content is organized in weekly or topic sections that are accessed on the main 

course page. Newly created course sites default to the topics format. Most of our faculty 

members use the topics format in order to have control over the content section names, so I 

often import a default template with the weekly class dates and holidays defined. Students like 

weekly sessions because it is easy for them to see what to do for each course session, and they 

have access to all the weekly content before and after class. Course sites often include guided 

online discussions that may continue beyond the course meeting. 

 

I am happy to help with alternative structures if an alternative structure would provide 

pedagogically effective support for your course activities and content. 

Adding and Rearranging Content Sections 

Content sections can be added to the site. If you click the [Turn editing on] button at the upper 

right or the select (Turn editing on) in the blue gearwheel menu at the upper right of the course 

page, + Add topics appears at the bottom right corner of the course page to add content 

sections. A content section can be relocated by clicking the cross-arrows in the upper left corner 

and selecting a location on the list that appears. Click the session that will follow the new 

content section. A content section can also be dragged to a different location using the upper-

left cross-arrows. I am happy to add sections for you if needed. 

  

Student Access to the Course Page 

As noted above, the default state of a new course site is inaccessible to your students while you 

are working on it. When your course site is ready for student access, click "Edit settings" in the 

menu accessed in the dark blue gearwheel icon at the upper right on the course page. Turn on 

student access by changing Course visibility [Hide] to Course visibility [Show] on the settings 

page. Then scroll down and click (Save changes) at the base of the "Edit course settings" page. 

When editing is on, an individual week or topic section can be made invisible to students by 

clicking “Edit” at the upper right corner of the section, and clicking “Hide topic”. The section can 

be made visible to students again by clicking “Show topic” 

  

Editing the Course Page 

  

Turn Editing On to Create or Modify Course Content 

To add, modify, delete, or rearrange content, click the [Turn editing on] button at the upper 

right or the select (Turn editing on) in the blue gearwheel menu at the upper right of the course 

page. 

  

Editing the Headers for the Weekly or Topics Content Sections  
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The content section label is easily revised when editing is on by clicking the pencil icon on the 

right side of the existing label. The label can be edited and will be saved when you press return. 

The section label type is blue and cannot be adjusted. The default section labels or your 

substitutes will appear as a list of links in the column on the left, where a section label may be 

clicked to jump to a chosen section. 

  

You can add a section header content label and images by clicking “Edit” at the upper right 

corner of the content section and selecting “Edit topic”. You can enter the academic topic label 

for the week or topic in the "Summary" edit area, where you have full control over the type 

design, and images can be included. A thematic image is sometimes included with the topic. 

Remember to scroll down and [Save changes] after editing. Teachers often use separate Label 

resources to define relevant content for the content section…Readings, Videos, etc. 

 

Adding Resources and Activities 

When editing is on, each section of the course site has a "Add an activity or resource" menu at 

the lower right of the section rectangle. This is how you include Resources such as Files, URLs 

(web links), or Pages, and Activities such as Quizzes, Assignments for posting text or files, and 

Forums for submission of work, discussion, and peer critique. 

When you select Add an activity or resource, a page of all the visual icons for “Activities and 

Resources” opens. At the top of the grid, you can choose the Activities icons or the Resources 

icons to clarify the grid. To include a selected item on your course site, click the icon image. The 

item will appear at the base of the session, but it can be moved. You can then drag the + icon 

left of the title to a new location or click the + icon left of the title to access a list of locations 

that you can click to relocate the item. 

 

Moodle Resources 

The Resources include: 

 Book 

 File 

 Folder 

 IMS Content Package 

 Label 

 Page 

 URL 

 

The Moodle docs for Resources:  https://docs.moodle.org/38/en/Resources 

 

• Create a Label for brief text that you want to appear on your page, such as the weekly topics, a 

https://docs.moodle.org/38/en/Resources
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Syllabus label where the Syllabus PDF is posted, headings for groups of related contents such as 

lists of Readings, or brief instructions for an activity or resource. Some teachers use a Label to 

display the Course Description in the course site header. A Label can also include links, images, 

video links for YouTube, etc. using the Label editor. There are instructions for the Label editor on 

the Moodle homepage under Moodle Help Documents. There is a Moodle Docs video about 

using sound and video files: https://docs.moodle.org/311/en/Label 

 

Resource Settings: Name and Description 

The “Edit settings” pages for the remaining resources have Name and Description text entry 

areas at the top. Remember to [Save and return to course] after entering text. The red (!) means 

the item is required. 

• In the required Name area, enter the name that you wish to appear on the course page. 

• You can include the name in the Description, or if you wish to include brief information below 

the resource name on the course page, you can enter it in Description and click the checkbox 

with "Display description on course page". If the checkbox is not clicked, the Description is not 

displayed. The Description will be converted to speech if someone uses a text-to-speech reader. 

 

• Use File to upload and share PDFs, text documents, images, video files, sound files, etc. Use 

Name to enter the label that should appear on the course page. In current browsers, you can 

drag and drop a file into the Select files rectangle. Then remember to scroll down and click [Save 

and return to course]. A PDF can be read full-format on screen in different browsers and systems 

and downloaded to your desktop or printer. Posted PowerPoint files must be downloaded when 

clicked and then viewed in the PowerPoint application, but they can also be saved as PDF files in 

the PowerPoint application and then uploaded as PDFs. 

 

 

• Use "URL" for individual links to web resources. Use Name to enter the label that should 

appear on the course page. In External URL paste or type the web address that is to be accessed. 

Remember to [Save and return to course]. URL can be used to link to Google Drive folders and 

documents. 

  

• A Page is a secondary online course page that appears when Page is clicked. Use Name to 

enter the label that should appear on the course page. In Content/Page content you can use the 

editor to add text, links, images, charts, embedded videos, and other media to the Page. 

Remember to [Save and return to course]. 

 

• You can use a "Folder" to contain a large group of files that might be distracting as a long list 

on the course page, but the contents of a folder cannot be read on the screen in Moodle. The 

https://docs.moodle.org/311/en/Label
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files must be downloaded from the folder, unzipped, and then viewed within an appropriate 

application. If you have only a few PDFs in a folder, it is better to use File to post them 

individually on the course page so the content can be viewed on the course page. 

  

• A "Book" resource can be used to create multi-page resources with a book-like format. The 

book module allows you to have main chapters and sub chapters. Students are not able to add 

content to a Book. In addition to text, images, flash movies and other multimedia may be 

included in a book. Books can be printed entirely or by chapter. 

https://docs.moodle.org/311/en/Book_module 

  

Drag and Drop Files on the Course Page using the Chrome Browser 

Using the Chrome or Safari browser with the current Moodle version, a document or image file 

can be added to the course page by turning editing on, and dragging the file onto the course 

site. With editing on, when you drag an image or document over a content section on the 

course site, a dotted line rectangle with “Add file(s) here…” appears at the base of the section. 

You can drag and drop an image, PDF file or Word doc directly onto the course site in the “Add 

file(s) here…” dotted line rectangle. You can then move it within the section if necessary, or 

move it to another section. You can then drag the + icon left of the title to a new location or 

click the + icon left of the title to access a list of locations that you can click to relocate the item. 

 

When you drop an image in the “Add file(s) here…” dotted line rectangle, you will have a choice: 

What do you want to do with the file…? 

      ( ) Add media to course page    (the image will be displayed) 

      ( ) Create file resource    (the image label will appear – click the label to display the image) 

Select one of the display options and then click “Upload” 

 

You can also display an image on the course page using a Label and the image upload icon in 

the editor. The image upload icon is a mountain in a square at the upper right of the formatting 

icons. Instructions for loading an image are in the Editor documentation on the Moodle 

homepage under Moodle Help Documents. 

  

Activities  

Use the +Add an activity or resource menu or the Add an activity menu to select an activity 

from the list: 

Assignment 

Attendance 

Chat 

Choice 

https://docs.moodle.org/311/en/Book_module
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Database 

External Tool 

Feedback 

Forum 

Glossary 

Lesson 

Quiz 

Survey 

Wiki 

Workshop 

https://docs.moodle.org/311/en/Activities 

 

Most faculty only use Assignment, Forum and Quiz. 

 

• Forum 

Many faculty members have effectively used Forum activities to engage the students in course 

discussion outside of class, and to enable the sharing and peer review of student course work 

outside of class. The Forum allows the content to be displayed in various ways. 

  

To post some text or add a file, open a Forum and click the [Add a new discussion topic] button. 

There is a Message input box with the Moodle formatting tools for posting text. If only one row 

in the formatter at the top appears, click the left icon to open all 3 rows. If you wish to upload a 

file, select "Advanced" at the lower right of the text entry box. The full Moodle editor and the 

Attachment drop-box will appear. Files can be added by dragging and dropping into the 

Attachment rectangle. Scroll down and click [Post to forum] when you have entered text or 

uploaded a file. 

 

You can grade a Forum if you open the menu in the Forum blue gearwheel icon, and select "Edit 

settings". Scroll down and select "Whole forum grading".. There is a Grade / Type pull-down 

menu. If you change the setting from [None] to [Scale] or [Point] the Forum will appear in the 

"Grades" page that can be accessed in the column on the left of your Moodle page. Most faculty 

use Point with Maximum grade [100]. Scroll down and click (Save and return to course). 

 

The Forum has a word count option if you have given an assignment with a required word 

count. When a forum is active on screen, click the Forum blue gearwheel at the upper right and 

select "Edit settings". On the Settings page select “Attachments and word count”. Change 

“Display word count” from [No] to [Yes]. Scroll down and click (Save and return to course). 

 

https://docs.moodle.org/311/en/Activities
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The Forum has a content Export option. When an existing Forum with content has been 

selected, click the Forum blue gearwheel icon at the upper right and click “Export” at base of the 

menu list. Select the “Format” pull-down menu to export content as a CSV, an OpenDocument 

text file or a PDF file, and click [Export] to download. You may wish to export the Forum content 

as an OpenDocument file, and then tweak it to clarify the formatting before printing. With the 

Users and Discussions options, you can export the entire forum with All, or select a specific 

discussion and specific user. 

  

You can access all of an individual student's forum contributions on screen if you enter a Forum, 

and click the [Search] button at the upper right. Near the bottom of the search field, "This name 

should match the author", enter a student's first or last name, or both first and last (whatever 

identifies them uniquely in the roster). Press Return or click the [Search] button below the name. 

All the forum postings by the named student will appear. You can also search a particular forum 

for the student's work using “Choose which forums to search” in the Forum options. 

  

• Assignment 

Many instructors use the "Assignment" activity for students to turn in work that needs to be 

graded online. Assignments can be critiqued and graded on the course site, and are 

automatically tracked in your Moodle Grades page. Students cannot see each other's 

submissions or grades. If students are required to upload PDF files for assignments, comments 

can be posted in the PDF file by the instructor when the file is accessed on the Grades page. The 

type of student content can be controlled in Edit settings/Submission types. You can activate 

Online text or File submissions or both. If you make changes, scroll down and click [Save and 

return to course]. 

https://docs.moodle.org/311/en/Using_Assignment 

  

• Feedback 

The Feedback module allows you to create and conduct surveys to collect feedback and do 

course evaluation. It allows you to write your own non-graded questions. The Feedback activity 

could be used for feedback on course issues, course activities and content, or on the use of 

Moodle in a course. https://docs.moodle.org/311/en/Feedback_settings 

  

• Quiz 

Many instructors are using Quizzes. There are several Quiz types: Short answer, Essay, Multiple 

choice, True/False, etc. After a Quiz is activated, named, and saved, select the Quiz, click "Edit 

quiz" in the blur gearwheel menu on the right, choose "Add" at the lower right and choose "+ a 

new question". Choose the "Question type" in the Questions list, click "Add" at the base of the 

list, and enter the question name and text, answers, etc. and click [Save changes]. Most teachers 

https://docs.moodle.org/311/en/Using_Assignment
https://docs.moodle.org/311/en/Feedback_settings
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use Multiple choice, True/False or Short answer. To edit an existing question, click the gearwheel 

"Edit" icon on the left of the question title for the question you wish to revise. 

https://docs.moodle.org/311/en/Building_Quiz 

  

• Wiki  

Some instructors have used Moodle Wikis successfully for student group work. Groups of 

students do research, and collaborate on the online presentation of their work in a Moodle Wiki 

for access by others in the course. When you select Wiki in the Activities list you get the initial 

settings page. 

Wiki name 

Description - your instructions for how the Wiki is to be used 

Choose Collaborative or Individual 

First page name 

  

After you activate the Wiki, open it to set it up for use. There is a Format option with three 

editing format choices. The HTML format uses the text and media editor that is used elsewhere 

in Moodle, so it is best to select HTML, and then click [Save and return to course]. Now when 

you enter the Wiki, the first page content appears. There are tabs at the top that allow you to 

View the content, or to Edit the content. 

 

To create additional pages, click the Edit tab, and in the editing area type the name of your page 

inside the double square brackets 

     [[Group 1 Project Presentation]] 

and click the (Save) button. The name of the new page appears in red. Click the red page name 

to activate the new page. You will be prompted to create it in the same way you created the first 

page. Select HTML and [Create page]. To return to the front page, click the "Map" tab. 

https://docs.moodle.org/311/en/Wiki_activity 

  

• Other Activities  

Most of the other activities have not been used yet in our context. You can always add an 

activity to your course site, experiment with it, and delete it if it does not enrich the learning 

experience for your students. 

  

Tracking Student Participation 

 

Search for a Student’s Forum Postings 

You can access all of an individual student's forum contributions on screen if you enter a 

Forum, click the [Search] button at the upper right. In the bottom search field, "This name 

https://docs.moodle.org/311/en/Building_Quiz
https://docs.moodle.org/311/en/Wiki_activity
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should match the author", enter a student's first or last name, or both first and last (whatever 

identifies them uniquely in the roster). Press Return or click the [Search] button below the 

name. All the forum postings by the named student will appear. You can also search a 

particular forum for the student's work using “Choose which forums to search” in the Forum 

options. 

 

Participant Activity Logs 

A log of activity in the course may be generated using the column on the left to select “Site 

administration”, then "Reports" and then "Logs". To generate a log, select any combination 

of student, date, activity and actions, then click the "Get these logs" button. The [All 

participants] [ more ] menu can be used to select a particular student. 

 

You can see what the students accessed, the time and date they accessed it, the IP address 

they came from, and their actions (view, add, update, delete). The log report page contains 

active links enabling you to access a student's profile page or a particular page that the 

student was viewing. You can download a log as a Text File, a PDF, an ODS (Open Document 

Spreadsheet) or an Excel spreadsheet by scrolling to the base of the list and using the 

"Download table data as" menu and the [Download] button. 

 

Individual Student Participant Reports in Student Profiles 

Click a student's name in your course site Participants list to access their Profile. 

Under "Reports" you can choose Today's logs, All logs, Outline report, Complete report, 

Grades overview, or Grade. 

"All logs" gives the date and time for each of the selected participant's access to course 

activities and resources. 

"Complete report" gives the number of times each course activity or resource was accessed 

by the selected participant, includes the texts from all their forum posts, and links to the 

course activities and resources. 

Under "Miscellaneous" you can access all of the posts and discussions in your Forums. 

  

Editing Course Site Headers, Resources, and Activities  

Click the [Turn editing on button at the upper left or click ]the blue gearwheel icon near the 

course page title and select [Turn editing on]. 

 

Edit a course header, week header, or topic header  

When Editing is on, at the upper right of the course site header, there is a small blue "Edit" 

which accesses the "Edit section" link. This opens the editing environment for the header, which 

can include the course name, instructor contact information, meeting times and locations, and 
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other appropriate text, links, images, etc. After posting content, scroll down and click [Save 

changes]. Activities and Resources are often inserted separately below the header text. 

 

Show or Hide Content for a Content Section 

When Editing is on, you can hide an entire week or topic content section from your students by 

clicking the small blue "Edit" icon that appears at the upper right of each. Click "Hide topic" to 

make the entire content section invisible to your students, or "Show topic" to make the entire 

content section visible to your students again. 

 

Edit Your Posted Resources and Activities 

When course site Editing is on, an "Edit" drop-down menu appears on the right side of each 

Resource and Activity, an "Edit title" pencil icon appears on the right side of the content section 

title, the cross-arrows "Move resource" icon appears on the left of each activity or resource title, 

and if the activity is a forum, assignment, or wiki, a head and shoulders icon appears to the right 

of the "Edit" drop-down menu to select the "No groups" head and shoulders, the "Separate 

groups"" white head and shoulders in a dark circle, or the "Visible groups" dark head and 

shoulders in a circle outline. 

 

The "Edit" menu on each installed Resource and Activity 

When you click "Edit" on the right side of a Resource or Activity: 

• Blue Gear wheel icon: "Edit settings" opens the settings page for the settings particular to 

the specific Resource or Activity, such as the content name, content description, content text, 

filename, URL, etc. After editing, there are buttons at the base of the page to [Save and 

return to course], [Save and display], or "Cancel". 

• Right arrow icon: "Move right" indents the content name and adds a "Move left" option to 

the icons. 

• Left arrow icon: "Move left" removes an indent. 

• Eye icon: "Hide" hides the activity or resource from your students. The title text will become 

gray, a / appears over the eye, and the word "Show" replaces "Hide" in the menu. Click 

"Show" to open the eye and make the content accessible to your students. 

• Garbage can icon: "Delete" deletes the content item. 

 

The Cross-arrows "Move resource" icon to the left of a resource or activity item name allows you 

to move the resource or activity anywhere on the course page. You can use it to drag and drop 

the item, or if you click the icon, a list of the items on the page appears and you can select a 

new location and jump to it. 

 

The Pencil "Edit title" icon close to the right end of the item label opens an edit box around the 
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title for title revision. Edit the title and then press Return to save the edit. 

 

The Head and shoulders "Groups" icon on the right side of "Edit" allows you to make a forum, 

assignment, or wiki accessible to all, or to restrict access to a predefined group. It has three 

settings: 

 

"No groups", a head and shoulders without a circle, which means no defined exclusive groups. 

This must be set for all individual students to access the site as individuals and not as members 

of a predefined group. Most MassArt course sites use this option. The individual students can 

access and respond to each other's work. They are sometimes required to interact with those in 

their own informal group, but are invited to respond to others that may interest them. 

"Separate groups" When you click the head and shoulders, the white head and shoulders in a 

dark circle appears and only defined group participants can contribute to and view their own 

predefined group. Content posted by other groups is not accessible, and individuals who are not 

in a defined group cannot access the content. 

Visible groups" When you click it again, the " dark head and shoulders in a circle outline appears 

and allows members to work only in their own predefined group but also to view the content of 

other groups. Click it again to return to the head and shoulders "No groups" setting. 

https://docs.moodle.org/311/en/Groups 

 

Tutorials and Documentation  

In addition to this document, links to other documentation are available at the top of the 

MassArt Moodle home page: 

Course Dates 

To Access Your Course Site 

Moodle Course Site Support 

Moodle Training & Documentation Links 

Ten Best Practices for Teaching Online 

Effective Practices for Blended Learning 

ARC Services (Academic Resource Center) 

MassArt Library Services 

In Moodle Training & Documentation Links, there are links to Moodle training videos, and 

documentation from Moodle. One of the links for the Moodle 3.8 Course Site Documentation is: 

http://docs.moodle.org/311/en/Managing_a_Moodle_course 

Moodle docs for specific aspects of a Moodle course site are available by clicking the (?) icons 

that appear beside the item titles on the "Edit settings" page for the course page and for each 

Resource and Activity you use. 

 

https://docs.moodle.org/311/en/Groups
http://docs.moodle.org/311/en/Managing_a_Moodle_course
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Blocks Columns 

Blocks are the administrative tools in the columns along the edges of the course site that 

provide information about the course site, course activities and the enrolled users. On an iPhone 

or narrow computer window, these appear below the course content column at the base of the 

page. On the MassArt Moodle homepage the essential default blocks on the left are:  

My Courses:  access to the links to courses in which you are a participant, the course 

participant list, etc. 

Site Administration:  access to "Edit settings" and a variety of other course and activity 

settings. 

Add a block: access to the Block menu. 

  

The homepage default blocks on the right are: 

Latest News 

My courses 

Calendar:  can include scheduled course deadlines, events, etc. 

 

On a course page, the essential default blocks on the left are: 

Participants: your course participant list with email addresses 

Grades: your grade-book 

Section links:  jumps to a selected week or topic section on the course page 

Dashboard: your links to current and past course sites 

My courses: links to all your active course sites  

  

On a course page, the essential default blocks on the right are: 

Activities:  short cuts to Forums, Resources, etc. 

Search Forums:  check Forum content for specific information 

Latest news 

Upcoming Events:  enter new events in the calendar 

Recent Activity:  shows recent contributions to Forums, uploads to Assignments, etc. 

 

When Editing is on, small editing icons appear on the right side of the title bar in each Block. 

Default Blocks on the right side can be deleted using the gearwheel icon "Actions" menu in the 

Block title bar. Some instructors remove the blocks in the column on the right to allow the 

course content column to extend to the right of the window. 

 

 

Preparing Your Materials for Use in Moodle  

If your presentations involve a large number of images, it is helpful to minimize the size of your 
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content presentation files before uploading them. 

 

Creating PDF Documents 

PowerPoint is a useful and widely used classroom presentation tool but the files cannot be 

displayed on the Moodle course page, and the files can be very large and difficult to download 

from Moodle if there are many images. Not all students have or want to buy Microsoft Office, 

and PPT documents can be edited by anyone who has access to them. It is useful to convert 

PPTs to compressed PDF (Portable Document Format) files for access on the course page in 

Moodle. PDF documents are readable on the Moodle course page, and they can be downloaded 

by selecting the down-arrow icon at the upper right. There is also a printer icon. 

 

Word documents cannot be viewed on the course page, but must be downloaded and read in 

Word. If Word documents do not need to be altered by your students they should be saved as 

PDF files for course site accessibility. Word has a PDF option in the Format pull-down menu 

when you select Save As, and when you select Print, one of the options in the pull-down PDF 

menu is "Save as PDF." 

  

PDFs can be viewed and printed using many different computers and operating systems, so 

students who don't have Microsoft Office to access doc, docx, ppt or pptx files can access the 

PDF course materials, see the content on the course page, and make prints. 

  

Convert a PPT to a compressed PDF for online sharing  

File compression is important to minimize the access time for course materials that include 

many images. Art History PPT files with many files are often 50mb or 100mb or more. A 

PowerPoint file can be reduced in size for screen viewing and then saved as a PDF in order to be 

accessible on the course page. 

In PowerPoint: 

- Save As 

- Reduce file size 

- Click [ OK ] 

- Save As 

- Use the "Format" pull-down menu 

- Choose "PDF" 

- Save 

 

If compression and conversion is confusing to you, contact me for help: 

Hubert Hohn:  hhohn@massart.edu, (Use email-Not in: Tower 724, 617-879-7289). 
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Word Processor documents 

If a course document is to be altered by a student and returned for markup, it can be saved as 

an RTF (Rich Text Format) file that works with all word processing software and operating 

systems for students who may use alternative word processing software such as OpenOffice, 

NeoOffice, Bean or Apple’s Pages. If you prefer to use a Word format, it may be helpful to save 

the file as .doc, not .docx, to accommodate students who may have an older version of 

Microsoft Office at home, or an alternate word processor that can import a doc file. 

Word documents with images are sometimes very large if the images have not been reduced in 

resolution for web delivery. A Word document with images can be compressed in recent 

versions of Word if you click an image. One of the picture editing options that appears is 

Compress. Choose "Best for viewing on screen (150 ppi)" and "Apply to: All pictures in this file". 

Click (OK) and save the document. 

 

 


